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Disclaimer of Warranty and Damages

IMPORTANT -- READ CAREFULLY BEFORE ACCESSING AND/OR USING 
THOROUGHBRED HANDICAPPER PRO

By accessing and/or using Thoroughbred Handicapper Pro, you indicate acceptance of the 
following terms:

Thoroughbred Handicapper Pro is provided "as is" without warranty of any kind. Whirlwind 
Technologies and its suppliers disclaim all warranties, either expressed or implied, including, but 
not limited to implied warranties of merchantability and fitness for any particular purpose and any 
warranty against infringement, with regard to Thoroughbred Handicapper Pro.

In no event shall Whirlwind Technologies or its suppliers be liable for any damages whatsoever 
arising out of the use of or inability to use this Whirlwind Technologies product.
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Introduction

Welcome to Thoroughbred Handicapper Pro, the complete thoroughbred horserace handicapping
system!

Powerful, yet easy to use for either the inexperienced horse player or computer user, you can 
handicap a race by using the mouse exclusively. In fact, there are very few places within the 
program that require any typing at all. Handicap a typical race in as little as 10 minutes.

Thoroughbred Handicapper Pro uses a combination of  commonly used handicapping 
techniques, assigning more points to data that weighs more heavily on the horses ability and 
chances for success.

Thoroughbred Handicapper Pro provides both basic and advanced handicapping. Basic 
handicapping is considerably faster, while advanced handicapping is more thorough, but requires 
more time and handicapping knowledge.

Thoroughbred Handicapper Pro also allows you to track all your wagers, including your net profit 
or loss for each individual race and for the day.

Thoroughbred Handicapper Pro provides two different well-designed and professionally done 
reports. The Individual Race Report lists the predicted order of finish for that given race, the 
point score for each horse, and the acceptable odds for wagering on each horse. This report also 
includes all the wagering information and results for that race. The Registered Version provides 
an Enhanced report which includes additional information and is printed out in a form-type format 
(border and grid lines separating each row and column). Additional blank columns are included in 
the enhanced report for writing in Finish Position; Payoff; Comments; etc. The reports may be 
printed and taken to the track to bet off of and to enter the results of the day's races. The Wager 
Summary Report summarizes all the wagers made for that day and provides you with your 
overall net profit or loss. The Registered Version provides an Enhanced report that is printed out
in a form-type format (border and grid lines separating each row and column). 

One of the best features of Thoroughbred Handicapper Pro is the ability to customize how 
Thoroughbred Handicapper Pro calculates the points for each horse (only available in the 
Registered Version). You can modify how much "weight" or percentage of the total score is 
assigned to each handicapping option, such as Finish Position, Lengths Behind Winner, Beyer 
Speed Rating, etc. This enables you to design your very own handicapping system!

We make no guarantees as to your own personal success in using Thoroughbred Handicapper 
Pro. However, by using the information provided by Thoroughbred Handicapper Pro AND your 
own common sense and good judgment, your chances of leaving the track with money in your 
pocket, hopefully with more than you started with, are improved considerably.

While we hope Thoroughbred Handicapper Pro will prove financially beneficial, be sure to make 
your wagers wisely and never bet more than you can afford to lose. Most of all, have fun at the 
track!
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Installation

1. Start Microsoft Windows.
2. Insert Disk 1 - Setup in drive A or drive B as appropriate.
3. From Program Manager, select File menu and choose Run.
4. Type a:\setup or b:\setup, depending upon which drive Disk 1 - Setup is in, and press ENTER.
5. The installation program will now begin. Follow the instructions on the screen.
6. After successful installation, a Program Group will be created that contains all the program 
    icons for Thoroughbred Handicapper Pro.
7a. Select Thoroughbred Handicapper Pro to start the program
7b. Select Thoroughbred Handicapper Pro Help to initiate the on-line help system
7c. Select Thoroughbred Handicapper Pro Manual to load the on-disk User's Manual (this file)
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Quick Start

Before getting started, you should have a copy of The Daily Racing Form in front of you for the 
day's race you want to handicap. The Daily Racing Form may be purchased at least one day in 
advance of the race date at numerous locations such as: News Stands; Convenience Stores; 
Grocery Stores; Drug Stores; etc.

Below are simplified step-by-step instructions for using Thoroughbred Handicapper Pro. More 
detailed instructions are provided within this manual, by pressing the F1 key to access help on 
each individual screen or searching through the Help Contents screen.

1)  Create a new file by selecting New, under the File menu.

2)  Select Track under the Enter Race Info menu. Setup each race on the card, or just the ones 
you are interested in. Select the Enter Horses command button to open the Horse Race Entry 
Screen. On this screen, enter the names of all the horses competing in that particular race in the 
order of their Post Position.

3)  Select Individual Race under the Enter Race Info menu. Enter handicapping information for 
each horse in the race.

4)  When through handicapping, select Make Wagers under the Wagers menu to enter any 
wagers you know in advance you are going to make.

5)  Under Reports menu, print desired report(s) to either printer or to the screen.

Well, that's about it for the basics! You are now ready to begin. As mentioned above, you can 
access Help during any part of Thoroughbred Handicapper Pro by simply pressing the F1 key.

Also, a sample file (LD092693) is included that you can open. This should provide additional help 
and ideas on how to use the program.
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File Dialog Box

Select or enter the name of the New file you want to create or the existing file you wish to Open. 
You may enter a description for each file that will help identify the file. Information such as 
Racetrack and Race Date might be helpful. Whenever you select OK to create or open a file, 
whatever text that is in the Description text box will be saved with the file.

You may also permanently delete files from within the File Dialog Box.
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Race Track Setup Screen

In this screen you enter the necessary setup information for each race of the day, or just the ones
you are interested in.

Race Date:
Enter date of the races

Race Track:
Enter name of the race track

Describe:
For each race, you may enter a short description which will be included in the reports. A typical 
description might be "6-1/2f - 15000 Clm" or "Maiden Special Weight", but you may enter 
whatever you wish.

Enter Horses
Click on this button to open the Racehorse Entry Screen, where you enter all the horses entered
in each particular race.

Entries:
The number in this box tells you how many horses are entered in the race. This information is 
taken from the number of entries entered in the Racehorse Entry Screen.

Racehorse Entry Screen
Enter the names of the horses competing in the race in the order of their Post Position.

- 8 -



Past Performance Input Screen

The Past Performance Input Screen is where you enter the information for each horse that will be
used to determine the horse's point score and the acceptable odds for wagering on that particular
horse. All the information on this screen can be found in the Daily Racing Form.

Race #1 refers to the horse's most recent race, Race #2 the second most recent, and Race #3 
the third most recent. The lower half of the screen is for Advanced Handicapping. It will only be 
available if Advanced Handicapping has been turned on. This option is available under the 
Options menu on the Main Menu.

BASIC HANDICAPPING

Didn't Finish "x" Races 
Select this option if the horse did not complete all 3 races. By complete, we mean actually finish 
the race. If the horse competed in a race but failed to finish because he stopped, lost his rider, 
etc., then completely disregard the race as though the horse was never entered.

If the horse has never competed in or finished a race, select Didn't Finish Any Races under 
Race #1. If the horse has raced only once, select Didn't Finish 2 Races under Race #2. If the 
horse has only two previous races, select Didn't Finish 3 Races under Race #3.

Last Call
Select the position of the horse at the last call of the race. This number is located to the 
immediate left of the horse's finish position.

Finish
Select the position the horse finished the race.

Behind
Select the distance the horse finished behind the winning horse. If the horse won, select the 
distance he finished ahead of the horse finishing second.

Trouble
This refers to whether the horse experienced any problems during the race. Examples would be: 
"4 Wide", "Steadied", "Bobbled Start", etc. You should not consider comments such as: 
"Weakened", "Tired", etc., as a Troubled Race. These comments describe the horse's 
performance, not an unexpected problem.

Select Yes or No, whichever is appropriate.

Races Run This Year
Select the total number of races run so far during the current racing season.

Amount Won This Year
Select the total amount of money won so far during the current racing season
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Past Performance Input Screen 
(continued)

ADVANCED HANDICAPPING

Jockey Win %
Select the winning percentage of the jockey who gets the ride in today's race.

Trainer Win %
Select the winning percentage of the trainer.

Suited To Race Distance
This requires some study and may be best left to more experienced handicappers.

If the majority of the horse's last 5 or 6 races have been at a significantly different distance than 
today's race, we need to determine whether today's race distance may help or hurt the horse's 
chances.

Moving From Shorter Distances To A Longer Distance - If you see a pattern of the horse 
always closing strong, but not winning, this would be a sign that the horse might be Better Suited
for a longer distance. By closing strong, we mean the horse shows a significant improvement in 
position from the Last Call to the Finish -- from 7th to 4th, 6th to 3rd, etc. In contrast, if the horse 
has consistently lost ground from the Final Call to the Finish -- from 2nd to 5th, 4th to 7th, etc., 
the horse would appear Less Suited to a longer distance.

Moving From Longer Distances To A Shorter Distance - If the horse shows a pattern of being 
in good position at the Last Call, but finishing poorly -- 1st to 4th, 3rd to 7th, etc., then the horse 
would seem Better Suited for a shorter race. If, however, the horse consistently closes strong 
and improves his position from the Last Call to the Finish -- 4th to 2nd, 7th to 4th, etc., then the 
horse would appear to be Less Suited for a shorter distance.

If you have any doubts whether the horse might be Better Suited or Less Suited, you should 
stay with the default, Same.

Not Raced Within A Month
Select if has been at least 30 days since the horse last raced.

Last Race Different Track
Select if the last race the horse ran was at a different track than today's race.

Route-Post Position #1
If this race is longer than 7 furlongs, but shorter than 1-1/8 Miles, then select if the horse is racing 
from Post Position #1.

Route-Post Position #2,#3
If this race is longer than 7 furlongs, but shorter than 1-1/8 Miles, then select if the horse is racing 
from Post Position #2 or Post Position #3.

Turf - 4th Plus On Turf
If this race is on turf, then review all of the horse's past performance listings in the Daily Racing 
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Form. If the horse has ran any races on turf in the past where he finished 4th or better or finished 
4 lengths or less behind the winner, select this option.
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Wagers

This screen is where you enter your wagering information for all the races.

Wager On...
Select the horse you are wagering on. Select EXOTIC if you are not betting on a single horse, but
a Daily Double, Exacta, etc.

Wager Type
Select the type of wager you are making. If not listed, type it in manually.

Amount
Select the amount you are wagering. If not listed, type it in manually.

Won
Select this box if you won your bet.

Lost
Select this box if you lost your bet.

Payoff
Enter the payoff for your wager. As listed on the tote board at the track and in the newspaper, 
payoff entered is for a $2.00 wager.

Profit/Loss
Thoroughbred Handicapper Pro automatically calculates and prints the amount won or lost for 
each wager.

NOTE:
Each bet is for a single wager. Bets such as $2 Across the Board must be entered separately. In 
this instance, you would have three separate bets -- $2 to Win, $2 to Place, and $2 to Show.

- 12 -



Individual Race Report

The Individual Race Report lists the predicted order of finish for that given race, the point score 
for each horse and the acceptable odds for wagering on each horse. This report also includes all 
the wagering information and results for that race. The Registered Version provides an 
Enhanced report which includes additional information and is printed out in a form-type format 
(border and grid lines separating each row and column). Additional blank columns are included in 
the enhanced report for writing in Finish Position; Payoff; Comments; etc. The reports may be 
printed and taken to the track to bet off of and to enter the results of the day's races. The 
enhanced report will print out almost identically to the screen display of the report.

Acceptable Odds:  This column, abbreviated ACPT on the printed report, provides probably the 
most useful information on the report. The odds listed for each horse are the lowest odds that 
Thoroughbred Handicapper Pro recommends considering making a wager on. For example, if a 
horse's Acceptable Odds is listed at 5/1, you should consider wagering on this particular horse 
only if the horse's Actual Odds are 5/1 or higher (6/1, 8/1, 12/1, etc.). The greater the difference, 
the more highly recommended the wager would be.

NOTE:     How the Advanced Handicapping option effects the Individual Race Report
The Advanced Handicapping option, accessed through the Options menu, controls whether the 
user may access the advanced handicapping options located on the bottom half of the Past 
Performance Input Screen. However, it can also effect the horse's point score on this report. If 
you have the Advanced Handicapping option on, the report will use this information when 
calculating the point score. However, if you later turn this option off, the report will disregard any 
advanced handicapping information previously entered when calculating the horse's point score.

Wager Summary Report

The Wager Summary Report summarizes all the wagers made for the day and provides you with 
the overall net profit or loss. The Registered Version provides an Enhanced report that is printed
in a form-type format (border and grid lines separating each row and column). The enhanced 
report will print out almost identically to the screen display of the report.
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Point Scoring Customization

This feature, only available in the Registered Version, allows the user to set how much 
emphasis, or weight, is assigned to each criteria that Thoroughbred Handicapper Pro uses to 
calculate the point totals for each horse. Modifying the values on this screen enables you to 
create your very own handicapping system!

The higher the number, the greater amount of emphasis is put on that scoring option. Selecting 
zero (0) causes Thoroughbred Handicapper Pro to completely disregard that scoring option.

Selecting the Default button will restore the scoring options to their original default values.

Any changes you make will be saved and used in the future whenever you create a new file or 
open an existing file.

Allow Extra Points For Troubled Race:
This option requires an explanation. For each race, Race #1, #2, and #3, Thoroughbred 
Handicapper Pro first adds the points earned (if any) for Last Call, Finish, Lengths Behind Winner,
and Beyer Speed Rating. If the horse had a troubled race (Yes was selected for Trouble for that 
particular race in the Past Performance Input Screen) and Allow Extra Points For Troubled 
Race is set to Yes, then this score is increased by the number shown for % Added. For instance, 
if % Added is 25, then the points earned for that particular race would be increased by 25%. If 
Allow Extra Points For Troubled Race is set to No, then no additional points are given, 
regardless of what is shown for % Added.

Advanced Handicapping

The Advanced Handicapping option, accessed through the Options menu, controls whether the 
user may access the advanced handicapping located on the bottom half of the Past 
Performance Input Screen. You turn Advanced Handicapping on or off by selecting the menu 
item. When a check mark appears to the left of the text, Advanced Handicapping is enabled.

The Advanced Handicapping option can also effect the point scores listed on the Individual Race 
Report. If you have the Advanced Handicapping option on, the report will use this information 
when calculating the point score. However, if you later turn this option off, the report will disregard
any advanced handicapping information you previously entered when calculating the horse's 
point score.
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Help System

Thoroughbred Handicapper Pro provides a very thorough on-line help system. The help system 
may be initiated from the Help menu (within the Main Menu) or by pressing the F1 key at any 
given time.

Thoroughbred Handicapper Pro's help system is context-sensitive. This means that when you 
press the F1 key to initiate help, the help system will automatically go to the help topic that 
applies to your current location within the program.
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Thoroughbred Handicapper Pro Registration Form
Upon registering, you will be sent a disk containing the current registered version of 
Thoroughbred Handicapper Pro. Registration provides the following benefits:

1) THE LEGAL RIGHT TO CONTINUE USING THOROUGHBRED HANDICAPPER PRO
2) Enables the Point Score Customization feature
3) Enables the Enhanced version of both the Individual Race Report and the Wager Summary 
Report
4) Notification of all future upgrades and the option to purchase any upgrade for 65% off the retail
price
5) Technical support via US Mail, Compuserve (71742,3632), or AOL (WWindTech)

Registration permits the user the license to use the registered version of Thoroughbred 
Handicapper Pro only on a single computer; a registered user may use the program on a different
computer, but may not use the program on more than one computer at the same time. 
Unauthorized duplication or distribution of the registered version of Thoroughbred Handicapper 
Pro is strictly prohibited.
_____________________________________________________________________________________

To register Thoroughbred Handicapper Pro, complete this form and mail it along with a check or 
money order made out to Whirlwind Technologies to:

Whirlwind Technologies, P.O. Box 1063, Van, TX 75790

The registered version of the program will be sent on 3.5" disk(s), unless specified otherwise.

You may also Register By Credit Card or Register Through Compuserve (refer to the following 
page for details).
_____________________________________________________________________________________

PRODUCT:  THOROUGHBRED HANDICAPPER PRO

VERSION:  2.0

COST:     $30.00

QUANTITY: ________

TOTAL:    ________

SHIP TO:
Name:        _______________________________________________________

Address1:    _______________________________________________________

Address2:    _______________________________________________________

City,St,Zip: _______________________________________________________
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Where did you get your shareware copy of Thoroughbred Handicapper Pro?

____________________________________________________________________
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Credit Card Registration

You can order with MC, Visa, Amex, or Discover from Public (software) Library by calling 800-
2424-PSL or 713-524-6394 or by FAX to 713-524-6398 or by CIS Email to 71355,470. You can 
also mail credit card orders to PsL at P.O. Box 35705, Houston, TX 77235-5705. The product 
number for Thoroughbred Handicapper Pro is #11045.

THE ABOVE NUMBERS ARE FOR ORDERS ONLY:

Any questions about the status of the shipment of the order, refunds, registration options, product 
details, technical support, site licenses, etc., must be directed to Whirlwind Technologies at P.O. 
Box 1063, Van, TX 75790.

To insure that you get the latest version, PsL will notify us the day of your order and we will ship 
the product directly to you

Register Through Compuserve

You may also register through Compuserve. To register, GO SWREG. Thoroughbred 
Handicapper Pro's Registration ID is 1668.

The registration price will be charged to your Compuserve account.
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